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License Agreement
This is a legal agreement between Licensee and Indigo Rose Software Design Corporation ("Indigo Rose").  Indigo Rose is willing to license this software to
you only upon the condition that you accept all of the terms and conditions contained in the following license agreement.  Please read the terms and
conditions carefully as continuing with the setup procedure will indicate your acceptance of all of the terms and conditions of the license agreement
("agreement").  If you do not agree to the terms and conditions, Indigo Rose Software Design Corporation is unwilling to license the software to you.

Definitions
"Software" shall be taken as referring to the AutoPlay Menu Studio files supplied in the software archive and to any and all copies, updates, modifications,
functionally-equivalent derivatives, or any parts or portions thereof.
"Licensor" shall be taken as referring to Indigo Rose Software Design Corporation.
"Licensee" shall be taken as referring to the person or business entity who purchased this License to use this Software or for whom such License was
purchased.

Grant of License
Upon acceptance of the Agreement, as evidenced by opening the software envelope, performing the setup procedure or using the Software, Indigo Rose
grants Licensee a non-transferable, non-exclusive, non-sublicensable license to use one copy of the enclosed software program (the "Software") on a single
terminal connected to a single computer.  Licensee may not network the Software or otherwise use it on more than one computer terminal at the same
time.  This Agreement gives Licensee the right to reproduce and distribute an unlimited number of copies of the menu systems generated by the Software,
including the files created by the Software such as autorun.exe, autoplay.exe and autorun.inf, provided that you are distributing these files as an
accompaniment to your software program.

Copyright
The Software and the accompanying documentation is protected by the copyright law of Canada and by international treaty provisions.  It may not be
reproduced in any form save for the sole purpose of making a backup copy for archival purposes.  You may not reproduce the written documentation
accompanying the Software.

Other Restrictions
You may not use, copy, modify, or transfer the Software or any copy, modification, or merged portion, in whole or in part, except as expressly provided
for in this Agreement.  Licensee shall not decompile, disassemble, or reverse engineer any of the Software or attempt to do so.  Licensee shall not rent,
lease, sublicense, or transfer the Software.

Proprietary Rights
Other than any license granted herein, Licensor retains exclusive proprietary rights (including all rights, title, and interest) in the Software.  Licensee
agrees not to represent that the Licensor is affiliated with or approves of Licensee’s application software in any way.  Licensee shall not use Licensor’s
name, trademarks, or any Licensor designation in association with Licensee’s application software.

Termination
This license is effective until terminated.  Licensee may terminate it at any time by destroying all copies of the Software covered by this Agreement and all
support files generated by the Software.  It will also terminate if Licensee fails to comply with any term or condition of this Agreement.  Licensee agrees
that upon such termination to destroy this Software, including all copies, functionally-equivalent derivatives, and all portions and modifications thereof in
any form.

Warranties: Disclaimers
THIS SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR  PURPOSE.  THE ENTIRE RISK AS TO THE
QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH YOU.  SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (NOT INDIGO ROSE
SOFTWARE DESIGN CORPORATION) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

Indigo Rose does not warrant that the functions contained in this Software will meet your requirements or that the operation of this Software will be
uninterrupted or error-free.  However, Indigo Rose does warrant the diskette on which the Software is furnished to be free from defects in materials and
workmanship under normal use for a period of ninety (90) days from the date of delivery to you.

Remedies: Limitations
Licensee’s sole and exclusive remedy against Licensor shall be, at Licensor’s sole discretion:
a.  the replacement of any diskette not meeting Indigo Rose’s "Limited Warranty" and which is returned to Indigo Rose, or
b.  if Indigo Rose is unable to deliver a replacement diskette which is free of defects in materials or workmanship, you may terminate this Agreement by
returning this Software and your money will be refunded.

IN NO EVENT WILL INDIGO ROSE SOFTWARE DESIGN CORPORATION BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST
PROFITS, LOST SALES, INJURY TO PERSON OR PROPERTY OR ANY OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF
THE USE OR INABILITY TO USE THIS SOFTWARE EVEN IF INDIGO ROSE OR ITS AUTHORIZED REPRESENTATIVE(S) HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.  IN NO EVENT SHALL LICENSOR’S LIABILITY EXCEED
AMOUNTS PAID TO LICENSOR BY LICENSEE UNDER THE TERMS OF THE AGREEMENT.

General
Licensee may not sublicense, assign or otherwise transfer this License or Software except as expressly provided in this Agreement.  Any attempt to
otherwise sublicense, assign, or transfer any of the rights, duties or obligations hereunder is expressly prohibited and will terminate this Agreement.

By running the setup procedure and installing the software, licensee acknowledges that licensee has read this agreement, understands it, and agrees to be
bound by its terms and conditions.  Licensee further agrees that this is the complete and exclusive statement of the agreement between us, which
supersedes any proposal or prior agreement, oral or written, and any other communications between us relating to the subject matter of this agreement.
This Agreement will be governed by the laws of the Province of Manitoba, Canada.
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Introduction
Thank you for choosing AutoPlay Menu Studio!  You now have the quickest, easiest way to make professional
AutoPlay menus at your fingertips.  This manual will be useful to you as a quick way to get started as well as an
invaluable reference as you use the program.

Who Should Use AutoPlay Menu Studio?
AutoPlay Menu Studio is designed for anyone distributing electronic content on CD-ROM.  Some examples are:

• A front end for a software package.  The menu will allow the user to run the software’s install program, read
the online documentation, jump to the technical support Web site, view or print the manual and so forth.

• Computer Based Training (CBT) applications.  AutoPlay Menu Studio can do many of things that much more
complicated and costly tools can do.  We just make it easier!

• Application demos are easy to create – complete with screen shots, sounds, hyperlink areas, videos and much
more.

• An introduction screen to a multimedia presentation.  The menu will open up and provide a link to start the
presentation from the CD-ROM, to jump to a Web site for more program details, and a link to send email to
the makers of the presentation.

• A front end for a CD-ROM that contains multiple products or demos.   The user will be able to read different
descriptions of the products, see screen shots, run the products’ install routines and link to a Web site where
they can order the products.

• A directory for a CD-ROM full of documents.  The menu can contain links to each of the documents and
allow the user to install the document viewer program if they don’t have it already.

Of course there are many, many more uses for AutoPlay Menu Studio.  The possibilities are limited only by your
creativity.

System Requirements
AutoPlay Menu Studio requires the following minimum system configuration to operate properly:

AutoPlay Menu Studio Design Environment
ü Windows 95, 98, NT 4.0, NT 5.0
ü 486 processor
ü 16 MB RAM
ü 800x600 SVGA display
ü Video card set to 15 bit 32K color or greater (recommended)
ü Sound card (recommended)
ü Mouse
ü 20 MB free hard drive space

AutoPlay Menu Studio Runtime
ü Windows 95, 98, NT 4.0, NT 5.0
ü 486 processor
ü 8 MB RAM
ü 640x480 SVGA display
ü Video card set to 8 bit 256 color or greater (recommended)
ü Sound card (recommended)
ü Mouse
ü 2 MB free hard drive space
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Installation Instructions
The following examples refer to your A: drive.  If you are installing the software from a different drive or
directory, substitute the appropriate information.

1. Start your Windows system in the usual manner.
2. Insert the AutoPlay Menu Studio disk into your A: drive.
3. Select Run... from the Start menu.
4. Type A:\SETUP.EXE into the box labeled “Open” and then press <Enter>.

Follow the instructions and the automated installation program will proceed to install AutoPlay Menu Studio
onto your hard drive.  A program folder and AutoPlay Menu Studio shortcut icon will be added to your system.
If you accept the defaults, these shortcuts will be added to your Start Menu under Programs > AutoPlay Menu
Studio.

Getting Technical Support
If you run into a problem or have a question about using the software, please let us know.  As a registered
AutoPlay Menu Studio user you are entitled to free unlimited (within reason) technical support on our Web site
and by email.  Annual dedicated support and update subscriptions are also available (see
http://www.indigorose.com/autoplay or email support@indigorose.com for details).  For best service, we
suggest you follow these steps in the order presented:

1. Read the manual!  Most of your questions can be answered here.
2. Refer to the Help menu within the program.  The help file contains additional detail about specific features

and options.
3. Check out the support section of our web site for answers to common questions and to find out about the

latest version of the program.
4. Email your question to support@indigorose.com.  We check our email throughout the day so you can expect a

quick reply.

When contacting us for technical support, it is important that you provide us with as much of the following
information as possible.  This will ensure that you receive a timely and useful answer to your question.

1. Your name, company name, email address, fax and phone numbers.
2. Your AutoPlay Menu Studio serial number.  The serial number is printed on your AutoPlay Menu Studio

diskette or on your registration letter.
3. The exact version and build number of AutoPlay Menu Studio that you are using.  You can find this

information by selecting Help | About from the menu.
4. The operating system you are using for both the design and runtime environments.
5. A detailed description of your question or problem.  If you are encountering an error message, we will need

to know exactly when the error occurs and the exact wording of the error message.
6. It is often very helpful if you attach the AutoPlay Menu Studio project file (“myproject.am2”) to your email

message so that our support technicians can open your project file and see exactly what you are doing.  Often
times “a project file is worth a thousand words.”
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Quick Start Tutorial
This chapter is intended to give you a brief overview of AutoPlay Menu Studio’s features and to enable you to use
AutoPlay Menu Studio quickly.  If you are a jump-right-in type this chapter is for you.

Lesson 1 - Starting a New Project
The first thing that we need to do is to create a blank project to work with.  To start a new, blank project:

1. Start AutoPlay Menu Studio.
2. Press the Close button on the Tip of the Day screen.
3. Click Cancel on the Template Gallery screen.

This will bring you to a blank window in which to start this tutorial.

Lesson 2 – Creating a Gradient Background
Next, we will create a background for the page that is more interesting than the default solid white.  To create a
gradient background:

1. Select Properties from the Page menu.
2. Choose Gradient in the Type field.
3. Choose your Foreground and Background colors.  The gradient will go from the foreground color at the top

of the screen to the background color at the bottom.
4. In the Title field, enter “My Test Menu” (without the quotes).
5. Click OK to accept the changes.

Now your screen will display a nice gradient background for your menu.  To learn more about backgrounds and
the Page Properties screen, please see page 23.
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Lesson 3 - Creating a Text Button
This is where your menu gets interesting.  We will now start adding some objects.  The first object we create is a
text button.  This button type is easy to use and very straight forward.

1. Select Text... from the Object menu.
2. Type “Exit the Menu” (without the quotes) in the Message field.
3. Click the Select Font... button. Select Times New Roman as the Font, Bold Italic as the Font Style, 24 as the

Size, and Red for the Color.  Click OK to accept the changes.

4. Choose Yellow as the Highlight color.
5. Click OK to create the button.

To learn more about Text Buttons, please see page 25.

Lesson 4 - Building the Menu
Your new button now appears at the top left corner of the menu on the design screen.  It is time to build and test
the menu to see how it works so far.

1. Choose Build from the Project menu.  This will open the Build screen.
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2. We will keep all of the default settings.  The only thing that you may want to change is the Output Path
option if you already use c:\output for something else on your system.  You can enter any directory and path
that you like.  If the directory that you specify does not exist, it will be created for you.

3. Click OK to start the build process.

When the build is complete, your menu will startup automatically so that you can test it.  Put the mouse over your
text button and notice the color change and the highlight sound that plays.  Click on the button and notice the
click sound.  Click the X in the top right corner of the menu to shut it down after you have finished testing it.

Now is also a good time to save your project.  To do this, choose Save As... from the File menu.  Save the project
as “Test Menu.am2”.

To learn more about building and testing your menu, please see page 44.

Lesson 5 - Setting the Action for a Button
Now let’s make the button actually do something.  Since the button says “Exit the Menu”, we will make it do just
that.  To set the Exit action for the button:
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1. Select the “Exit the Menu” button by clicking on it.
2. Select Properties from the Object menu.  This will open the Text Button Properties screen.
3. Click on the Action tab.
4. For the Command field, select Exit.
5. Click OK to accept the changes.

Now build and test your menu again.  This time you will see that when you click the Exit the Menu button, the
menu will shutdown.

To learn more about actions and the Action tab, please see page 29.

Lesson 6 - Creating a New Page
One of the powerful new features of AutoPlay Menu Studio is the ability to create multiple page menus.  To create
a new page:

1. Select Add from the Page menu.
2. The Rename Page dialog will be opened which allows you to name your page.  Enter “Page 2” (without the

quotes) as the page name.
3. Click OK to create the new page.

Your new page will appear and be selected in the design environment.  Notice that you can easily switch back and
forth between pages by clicking on the page’s tab as illustrated below.

Lesson 7 - Using an Image Background
Although the gradient backgrounds look good, they can be a little boring.  You may want to use a custom bitmap
for your background.  To specify a custom bitmap:

1. Click on the Page 2 tab.
2. Select Properties from the Page menu.
3. Select “Bitmap Image - Normal” in the Type field.
4. For the Standard Image File, click on the button with the three dots, go to the Library\Backgrounds folder in

your AutoPlay Menu Studio directory and select “clouds.pcx”.
5. For Title, type “Test Menu Page 2”.
6. Click OK to accept the options.
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You’ll probably notice that the image is a bit grainy.  That is because you are viewing the image with Automatic
Palette Management turned on.

You can make the image look much better by turning off the Automatic Palette Management feature.  To turn off
Automatic Palette Management:

1. Select Settings from the Project menu.
2. Uncheck the Automatic Palette Management option.
3. Click OK to accept the changes.

By turning off the Automatic Palette Management feature we told AutoPlay Menu Studio that we will manage our
own palette.  That is, AutoPlay Menu Studio will not convert all of our standard images to a common palette.

To learn more about images, color depths, standard and true-color images and Automatic Palette Management,
please see page 16.

Lesson 8 - Creating Image Buttons
Image buttons offer the most flexibility for the look and effect of a button.  To create an Image Button:

1. Click on the Page 1 tab.
2. Select Image... from the Object menu.  This will open the New Image Button screen.
3. For the Normal Button Image option on the Standard tab, click the browse button (“...”) and select

“Next.pcx” from the Library\Buttons\Widgets folder.
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4. For the Highlight Button Image option on the Standard tab, click the browse button (“...”) and select “Next
High.pcx” from the Library\Buttons\Widgets folder.

5. Click OK to create the button.
6. Drag the newly created button to the bottom right part of the screen.
7. Build and test your menu as described in Lesson 4.

We will not specify a True-Color image for this particular button because the image that we are using is 16-color
and would not benefit by an increased color depth.  If you do go to the True-Color tab, you will see that the Same
as standard image option has been chosen.

To learn more about Image Buttons, please see page 26.

Lesson 9 - Jumping to Other Pages
Now that you have several pages going, you need a way to jump from one page to another.  To make the “Next
>” button that we created in Lesson 8 jump to Page 2:

1. Right-click on the “Next >” image button and select Object Properties... from the pop-up context menu.
2. Click on the Action tab.
3. Select Jump to Page in the Command field.
4. Select Page 2 in the Target field.
5. Click OK to accept the modifications.
6. Build and test the menu as described in Lesson 4.
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Now you will notice that the “Next >” button takes you to Page 2 when the menu is run.  To make it so that you
can get back to Page 1 from Page 2, create an Image Button on Page 2 that jumps back to Page 1.  Follow the steps
from Lesson 8 and 9 and use the “Back.pcx” and “Back High.pcx” from the Samples folder.  Place the “< Back”
button in the lower left part of Page 2.

To learn more about Actions, please see page 29.  For more information about Image buttons, please see page 26.

Lesson 10 - Jumping to a Web Site
The final lesson will be to make a button that jumps to a Web site.  To make a text button that jumps to a Web site:

1. Go to Page 2.
2. Create a text button by following the steps in Lesson 3.  Use “Jump to http://www.indigorose.com” as the

button text.
3. Open the Text Button Properties screen by double-clicking on the new text button.
4. Select the Action tab.
5. Select “Open URL (Web Site)” for the Command.
6. Enter “http://www.indigorose.com” (no quotes) in the Target field.
7. Click OK to accept the changes.
8. Make sure that you are connected to the Internet.
9. Build and test the menu as described in Lesson 4.

This concludes the Quick Start Tutorial.  Please read the rest of this manual and the Help file as well to gain a
good working knowledge of all of the product’s features.
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Getting Started

The Development Environment
AutoPlay Menu Studio’s development environment is similar to that of other visual WYSIWYG (what you see is
what you get) tools.  Take time to familiarize yourself with the basic elements of the main screen before
continuing on.

At the top of the screen is the menu bar.  The menu allows you to access all of AutoPlay Menu Studio’s
commands.  Below the menu are the toolbars, which provide access to many of the commands as well.  To find
out what a toolbar button does, position and hold the mouse over the button and a ToolTip will appear.  As well,
a description of the button or menu command’s functionality will appear on the status bar at the bottom of the
screen.

The design window is the large area of the main screen.  The design window contains tabs called pages.  This is
where the visual designing of your menu takes place.  The design window will give you a good idea of what your
menu will look like in the end.  In order to see exactly what it will look like, however, you should build and run
your menu.  You will position “button objects” on the design window, which perform various actions.  You can
read more about the buttons and actions in the chapters entitled Creating Objects and Setting Actions.

The dotted and dashed line (“  - -   - - “) on each page represents the viewable area of your menu when you
build it.  This is to act as a guideline so that you know how to place your objects.  You can change the size of the
menu screen from the Project Settings screen (see page 18).  You can turn off this line by setting the Show Window
Size Outline option on the Preferences screen.

Setting Environment Preferences
There are several general environment preferences that can be set from the Preferences screen.  To open the
Preferences screen, select Edit | Preferences.  The Preferences screen has the following fields:

Menu
Toolbar

Status
Bar

Text Button

Image Button

Hyperlink Button

Pages

Design Window
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Highlight   The default sound that will be used as the Highlight Sound for any new buttons that are created.  You
can click on the browse button (the one with the three dots, “… ”) to open a dialog box that will let you browse
your system for a sound file.  You can click the button with the speaker icon for a preview of your sound.

Click   The default sound that will be used as the Click Sound for any new buttons that are created.  You can click
on the browse button beside this field to open a dialog that will let you browse your system for a sound file.  You
can click the button with the speaker icon for a preview of your sound.

Temporary files directory   The directory on your hard drive where temporary files will be stored during the
menu building process.  This directory should be located on a drive with at least 20MB of free disk space.

Execute menu after build is finished   If checked, the menu will be run once the build process is complete.

Show hyperlink outlines   If checked, hyperlink buttons will show up in the design environment as dashed lines.
Show window size outline   If checked, the dashed and dotted line that shows you the viewable area of your
menu will be displayed.

Show Template Gallery at startup   If checked, the Template Gallery will appear when starting up the AutoPlay
Menu Studio.  If you turn this option off, you can still start the Template Gallery at any time from Project |
Template Gallery on the menu.

Understanding Graphic Images
In order to get the best results out of AutoPlay Menu Studio, it is important to have a good understanding of
graphic images, palettes and color depths.  This section will provide a basis for understanding these concepts.
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Palettes and Color Depths
There are three basic color image types used on Windows systems: 16-color (fixed system palette), 256-color
(palletized) and 16 million color (non-palletized) images.

Palettes cause problems when you try to display multiple images with different palettes in the same window at
the same time on a 256-color system. In that case, all images are forced to use the palette of the last loaded image,
which will cause palette clashes and ugly effects.  This can occur in AutoPlay Menu Studio when you use images
with different palettes for the background image and graphic buttons, for example.   This problem does not exist
on non-palletized systems.

The only way to avoid these issues on palletized systems is to use one common palette for all of your standard
images (see the next section for more information about standard images).  There are two ways to ensure that all
of your standard images use the same palette in AutoPlay Menu Studio:

1. Use an image-processing program to make sure that all of your 256 standard color images use the same
palette.

2. Turn on AutoPlay Menu Studio’s Automatic Palette Management feature (see the Automatic Palette
Management section below for details).

How AutoPlay Menu Studio Handles Images
Since you want your menu to look good on all systems, AutoPlay Menu Studio always stores two copies of each
image in your menu.  One image, the standard image, will be used on palletized (256 color) systems.  The other
image, the true-color image, will be displayed on non-palletized systems.  At runtime your menu will determine
what color depth the user is running at and display the appropriate image.

You will find the true-color and standard image options on the Background tab of the Page Properties screen (see
page 23) and on the Standard and True-Color tabs of the Image Button Properties screen (see page 26).

After specifying a standard image, several things will happen (in this order):

1. The image that you specify will automatically be copied and used as the true-color image as well.  The image
will not be changed in any way - an exact copy of the original will be made.

2. If the image that you specified is greater than 256 colors, the standard image will be automatically reduced to
256 colors.

3. If you have Automatic Palette Management turned on, the standard image will be mapped to a common
palette.

If you don’t want to use a copy of the standard image for the true-color image, you can always specify a different
true-color image on the True-Color tab (Image Button Properties screen) or the True-color image file field (Page
Properties screen).

At design time, you can switch between viewing the standard and true-color images from the View menu.  Keep
in mind though that you will only see a true representation of the standard images (read: Palette clashes) if your
system is set to 8 bit 256 color.  And of course you will need it set higher if you want to properly see the True-
Color images.

Automatic Palette Management
The Automatic Palette Management feature in AutoPlay Menu Studio is used to ensure that all of your standard
images use a common palette when displayed on 256 color systems.  You can turn Automatic Palette Management
on or off from the Project Settings screen (see page 18).
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Unless you are displaying only one graphic image per page or manually design your images to use a common
palette, you should turn the Automatic Palette Management feature on.  Automatic Palette Management will not
have an effect on non-palletized systems or your true-color images.

How to Get the Best Results from Your Images
There are several options for getting the best possible results from your images on the widest range of systems:

1. Create all of your standard images as 256-color images with a common palette and turn off the Automatic
Palette Management.  This will always look good on 256 color systems.

2. Use a background image with hyperlink or text buttons.  If you only have one image per page, you can use a
256-color background image without worrying about the palette. Since hyperlink buttons are essentially
transparent and text buttons use the built-in system colors, you will not need to worry about the palette at all.

To learn more about button objects, please see page 24.

Working with Projects

What is a Project?
An AutoPlay Menu Studio project is a collection of the pages, objects and settings used to create one menu.  The
project file is not the autoplay menu itself and you should not distribute it.  It is the document file that is used to
hold project information that can be saved from and re-loaded into the AutoPlay Menu Studio development
environment.  AutoPlay Menu Studio projects have the file extension “.am2”.

The Project Template Gallery
The Project Template Gallery is a great way to get your AutoPlay Menu Studio project going as quickly as
possible.  You can choose from a variety of menu styles and options, and then customize the starter project to
meet your needs.

The Template Gallery is automatically displayed whenever you start AutoPlay Menu Studio (see Edit |
Preferences to change this). You can also view it at any time by selecting Project | Template Gallery... from the
menu.

Once you select a project template you will usually have to do some customizing before the project is ready.  You
will especially need to make sure that you check each button’s actions to make sure that they are calling your files
correctly.

New project templates will be made available from time to time.  Check out our web site for information on new
templates and how to make your own.

Project Settings Screen
The Project Settings screen allows you to select some global settings that affect the appearance and functionality of
your menu.  You can open the Project Settings screen by selecting Project | Settings from the menu or by right
clicking on the background and selecting Project Settings.  The Project Settings screen has four tabs - General,
Startup Page, Intro Video and Advanced.

The General tab has the following fields:
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Show title bar   If checked, the title bar at the top of the menu screen will be displayed.  If unchecked, your menu
will not have a title bar and its associated control buttons.  Uncheck this button with care!

Automatic palette management   If checked, AutoPlay Menu Studio will map all of your standard images to a
common palette to avoid palette clashes on 256 color systems.  Please see Understanding Graphic Images on page
16 for more details about palettes, color depths, standard images and Automatic Palette Management.

Width/Height   The width and height in pixels of the menu screen at runtime.  This size includes the title bar (if
you have chosen to show it) and the window borders.

The Startup Page tab allows you to select the menu’s startup page depending on the language of the user’s
system.  See Multilingual Menu Support on page 34 for more details about these options.

The Intro Video tab lets you display an AVI movie before your menu appears.  The Video tab has the following
options:
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AVI Video File   The full path and filename of the video that you want to play at startup.  The video must be in
.avi format and it is highly recommended that you use a standard Codec when creating your movie file.  This will
ensure playback on all systems.  Refer to your video editing software for more details.  You can click on the
browse button (“...”) to browse for your file.  You can click on the test button (the one with the camera on it) to
preview the video using your system default avi player.

Background   The color of the screen background when playing the movie.

Volume   The volume to play back the video’s sound at.  100 is normal, 50 is ½  of normal, 0 is no sound, etc.
Minimum = 0, Maximum = 100.

Speed   The speed at which to playback the video.  100 is normal speed, 50 is ½  speed, 200 is twice normal speed.
Minimum = 0, Maximum = 200.   Keep in mind that video playback is very processor intensive.  Some systems
may have trouble with an increased frame rate.

Display Size   The size of the video during playback.  Choose from:

Display Size Effect
Normal The video will be displayed at its normal

default size.
Full Screen The video will be proportionally resized to fill

as much of the screen as possible.
Zoom The video will be proportionally zoomed by the

factor specified in the edit box below the
option.  100 is normal size, 50 is ½  size, 200 is
double the normal size.
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Stretch The video will be stretched to the Width and
Height specified in the edit boxes below the
option.

Note that the video will be automatically centered on the screen during playback.  The display size will
dramatically affect the playback quality of your video.  Depending on the viewable size of the video, many
systems will be using up most of their processing power just trying to show the video at normal size.  Obviously
full screen video needs considerably more processing power.  A 200% zoom is generally as large as you will want
to go for most practical purposes.  You will want to play around with these settings in order to achieve the best
results for your situation.

Allow click to skip   If checked, the user will be able to bypass the video by left-clicking the mouse.

The Advanced tab allows you to set advanced settings for the menu such as the startup condition, a password
and any registry changes that should be made when the menu is started.  Please see page 36 for details about the
Advanced tab options.
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Working with Pages

Introduction to Pages
The screens that appear in your menu are referred to as pages in AutoPlay Menu Studio’s design environment.  A
tab represents each screen of your menu.  Each page has its own unique properties and objects.  This chapter will
look at how to work with pages.

Creating New Pages
When you create a new project, the menu has just one page called “Page 1”.  If you want to add a new page to
your menu, select Page | Add from the menu.  A new page will be added to the end (furthest right) of the existing
pages.

Renaming Pages
When new pages are created they are called “Untitled” by default.  You will want to rename these pages to
something more meaningful.  To rename a page, select Page | Rename…  from the menu.  You will be prompted
for the new name.  Be sure to keep your page names unique!

When you rename a page all references to that page within AutoPlay Menu Studio will be automatically updated.
For example, if a page in your menu has a button that jumps to a page called “Page 3” and you rename “Page 3”
to “My Page”, the button that jumps to it will be updated to say “My Page”.

Moving and Copying Pages
To move a page to a new position or create a copy of the page, select Page | Move or Copy.  This will open a
dialog box allowing you to move the selected page to a new position or insert a copy of the page into the location
you specify.

Deleting Pages
You can delete a page by selecting Page | Delete from the menu.  Please note that you cannot undo a page
deletion, so make sure that you really want to delete the page before you do it.

If the page that you deleted is referenced by jump actions on other pages, you will need to make sure that you
change those references to the deleted page as well.

Specifying the Startup Page
The first page that is displayed when the menu is run is determined by the Startup Page tab of the Project Settings
screen (see page 34).  By default, this will be the page called “Page 1”.  You can change the startup page for
individual languages or all languages on the Startup tab.

Page Properties
The Page Properties screen is where you can determine how a page looks and what a page does.  You can open
the Page Properties screen for the currently selected page by:

1. Double clicking on the page.
2. Selecting Page | Properties from the menu.
3. Right clicking on the page and selecting Page Properties... from the context menu.

Page Properties has four tabs:  Background, Sounds, Open and Close.   
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Background Tab
The Background tab has the following fields:

Type   The type of background that you want to use for your Window.  Choose from a variety of options such as
gradients, patterns, solid colors and bitmap images.

Foreground   The color that will appear at the top of the screen when using the gradient background type.  If
using a pattern, this will be the color of the pattern lines.

Background   The color that will appear at the bottom of the screen when using the gradient background type.  If
using the solid color background type, this will be the background color of the screen.  If you are using a bitmap
background, this will be the color of the non-image area, if any.

Standard/True-Color Image File   The path and filename of the standard and true-color images that will be used
as the background image.  If you do not specify a true-color image, the standard image will be used on non-
palletized systems.  Please see page 17 for more information about standard and true-color images.  This option is
only applicable if using a bitmap for the background.

Window Title   The text that will appear in the window’s title bar.

Sounds Tab
The Sounds tab specifies the sounds that will be used for the opening and closing of the page.  The Sounds tab
contains the following fields:

Filename   The full path and filename to the sound that you want to use when the page opens/closes.  You can
click the browse button (“… ”) to browse for the .wav file on your system.  Click the button with the speaker to
test your sound.

Wait for playback   If checked, the sound will finish playing before any other events will occur.

One time   If checked, the page sound will only play once per session.

Open and Close Tabs
The Open and Close tabs are just Action tabs with one exception.  They have a One Time Only field.  If checked,
the Open or Close action will only be executed once for that page per session.  For more information about the
Action tab, please see page 29.
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Creating Objects

Introduction to Objects
An object is any element that is placed on a page.  AutoPlay Menu Studio has three types of objects:  Text buttons,
Image buttons and Hyperlink buttons.

You can place an object on a page by selecting Object and then Image, Text or Hyperlink from the menu.  When
you create a new object in this way, an object properties screen will open automatically.  This is where you set the
sounds, actions, attributes and other settings for your new object.  Once you have completed your settings, click
OK and the new object will appear on the screen.

Common Object Properties
All objects have four common properties tabs.  They are the Sounds tab, Action tab, Attributes tab and the
Advanced tab.  Each of these common tabs are described in detail below:

Sounds Tab
The Sounds Tab allows you to choose the sounds that will play when the user passes the mouse pointer over the
object or when the object is clicked.

Highlight sound file   The full path and filename to the sound that you want to hear when the mouse pointer
passes over the object.  You can click the browse button to search your system for a .wav file.  Click the speaker
button to test your sound.  Check the Wait for playback option if you want the sound to finish playing before any
other event can occur.

Click sound file   The full path and filename to the sound that you want to hear when the object is clicked. You
can click the browse button to search your system for a .wav file.  Click the speaker button to test your sound.
Check the Wait for playback option if you want the sound to finish playing before any other event can occur.

Action Tab
Here you select the action that will take place when the object is clicked.  For a detailed description of the Action
tab and actions in general, please see page 29.

Attributes Tab
The Attributes tab allows you to set some general properties of the object.  The following fields are available:



AutoPlay Menu Studio 2.0 Pro 25

Name   The name of the object.  Useful for identifying the object.

Cursor   The look of the mouse pointer when it is positioned over the object.

Left   The number of pixels that the object is offset from the left side of the screen.  You can also change the
position of an object by dragging and dropping it.

Top   The number of pixels that the object is offset from the top of the screen.

Width   The width of the object in pixels.  If this field is grayed out, the width is for informational purposes only
and can not be changed from this screen.

Height   The height of the object in pixels.  If this field is grayed out, the width is for informational purposes only
and can not be changed from this screen.

Advanced Tab
The Advanced tab allows you to set advanced options for the object, such as Passwords, the Show/Hide
condition and the Registry Update.  Please see page36 for a detailed look at the Advanced tab and its functions.

Text Buttons
Text Buttons are quick and easy to design and they look good at all color depths.  Text Buttons have the Text tab
in addition to the common object properties.  The Text tab allows you to set the attributes of the Text button.
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Message   The text that you want to display.

Select Font   Opens a font dialog which allows you to choose the type and style of font to use for the button text.
You must use a True-Type font.  Please note that you will need to make sure that you have redistribution rights
for the font that you choose.  Please contact the maker of the font for redistribution information.  It is always safe
to use Arial, Times or Courier fonts since they are distributed with Windows.

Normal   The color of the text when the mouse pointer is not over it.

Highlight   The color of the text when the mouse pointer is over it.

Image Buttons
Image Buttons are buttons that display graphic images.  Since you design the images used, Image Buttons are
extremely flexible and completely customizable.  Make sure that you have a good grasp of how to use images and
palettes before using graphic buttons (see page 16).  The Image Button screen has the Standard and True-Color
tabs in addition to the common tabs.  The Standard and True-Color tabs are used to specify the Standard and
True-Color images.  For more details about Standard and True-Color images, please see the section “How
AutoPlay Menu Studio Handles Images” on page 17.

The Standard and True-Color tabs are exactly the same except for one option.  The True-Color tab has a box
labeled Same as standard image which, if checked, uses the Standard image settings for the True-Color image.
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Normal Button Image   The image that will appear when the mouse pointer is not over the button.  Specify the
full path and filename of the image file in the first field.  Use the browse button to help locate the image file on
your system.  Check the Transparent background box if you want the image’s background to be transparent.  By
default, the color of the pixel in the upper left corner of the image will be used as the transparent color.  If you
want to select a different color, click the Color... button.  The mouse pointer will turn into a crosshairs.  Then click
on the color that you want to make transparent.

Highlight Button Image   The image that will appear when the mouse pointer is over the button.  The options are
the same as those for the Normal Button Image.

Hyperlink Buttons
A Hyperlink button is used to turn a section of your background into a “hotspot”.  In design mode, it will show
up as a hollow box surrounded with a dashed line pattern (assuming that you have the Show hyperlink outlines
option selected under Preferences).  The Hyperlink Button Properties screen contains only the four standard
object tabs.  You can change the dimensions of the Hyperlink area either interactively or through the Attributes
tab of the Properties screen (see page 24).

Arranging and Aligning Objects
Once you have created your objects, you will need to arrange them on your page.  AutoPlay Menu Studio
provides a number of features to help you with that task.

Selecting Objects
In order to perform any operation on an object(s), you must first select the object(s).  There are a couple of ways to
select an object:
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1. Click an object with the left mouse button.  To select multiple objects, hold down the Ctrl key while clicking
on them.

2. Click and hold down the left mouse button while dragging the  “rubber band” to completely include the
object(s) you want to select.  Let go of the mouse button to complete your selection.

Moving Objects
To move a single object, click on the object and then drag and drop it in the desired position.  To move multiple
objects, select them, hold down the Ctrl key and drag and drop them in the desired location.

Aligning Objects
Once you have selected your objects, you can use AutoPlay Menu Studio’s alignment tools to quickly arrange
them.  All alignment tools are located under the Object menu.  The alignment tools allow you to space, align,
center and order the objects.  For a detailed description of the alignment options, please refer to the online help
file
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Setting Actions
Actions are the “heart and soul” of AutoPlay Menu Studio.  Actions make things happen when an object is clicked
on or a page is displayed.  Actions can be assigned to any object - image buttons, text buttons and hyperlink
buttons as well as to page open and close events.  Actions are defined on the Action tab (for buttons) or the Open
and Close tabs (for pages).

The Action Tab
The Action tab has the following fields:

Command   The action to perform.  The following commands are available:

Command Description
None No action will be performed.
Execute Program Executes a program.
Open Document Opens a document file.
Open URL (Web Site) Opens an Internet URL.  This can be a Web site

address (http://), ftp location (ftp://) or email
address (mailto:).

Print Document Prints a document.  The print verb must be
supported by the viewer application.

Explore Folder Opens a drive or directory using the Windows
Explorer.

Play Multimedia Opens and plays a multimedia file.
Custom Verb Opens a file using a custom shell verb.
Jump to Page Jumps to another page in the menu.
Exit Exits the menu.
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Target   The fully qualified name of the file to act upon.  In other words, this is the complete drive, directory and
filename as it can be found when the menu is run.  In most cases you will not know the drive letter until runtime.
This is where the variable %SrcDrv% comes in handy.  It represents the drive letter of the user’s CD-ROM drive
(or more precisely the drive that the menu is being run from).  So, for example, if you want to execute a program
called setup.exe that will be located in the root of your CD-ROM, you would specify %SrcDrv%\setup.exe as the
target.

Command line arguments   Any command line arguments that should be passed to the program named in Target
File.

Working directory   The working directory of the program named in Target File.  If you do not specify a working
directory, it will be the same as the Target file’s directory.

Shutdown after Action   If selected, the menu will be shut down after the action is initiated.

Mode   The run mode for the file named in Target.  Choose between Normal, Maximized or Minimized.

Custom Verb   This field will only be visible if Custom Verb is selected as the Command.  AutoPlay Menu Studio
already supports common verbs like Open, Play and Print through the commands by those names.  The Custom
Verb feature is for any other unanticipated verbs that you may run across.  Please refer to your application’s
documentation to find out what, if any, custom shell actions are supported.

Jumping to Another Page
One of the powerful new features of AutoPlay Menu Studio is its support for multiple pages.  To get the most out
of the software, it is important to know how to make your pages interact properly with one another.  To create an
action that jumps from one page to another, select “Jump to Page” as the Command and enter the page name as
the Target.

Example:
To create an action that jumps to a page called “Page 2”, enter the following values in the action tab:

Field Value
Command Jump to Page
Target Page 2
Command line arguments Not Applicable
Working directory Not Applicable
Mode Not Applicable
Shutdown after Action Not Applicable

Running a Program
One of the most common applications of AutoPlay Menu Studio is to launch or execute programs.  This could be
your installation program, your main executable or just about anything else you are distributing on your CD-
ROM.  To create an action that executes a program, set the Command field to “Execute Program”, then specify the
path and filename of the program in the Target field.  Fill in the Arguments and Working Directory fields as
required.

Example:
To set an action that executes an installation program called “setup.exe” which will be located in a subdirectory
called “\install” on the CD-ROM, enter the following values in the Action tab:

Field Value
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Command Execute Program
Target %SrcDrv%\install\setup.exe
Command line arguments << Leave Blank >>
Working directory %SrcDrv%\install
Mode Normal
Shutdown after Action Unchecked

Example:
There is a program called “viewer.exe” that is used to view XYZ data files.  There is an XYZ data file called
datafile.xyz in a subdirectory of the CD-ROM called “\files\xyzfiles”.  Viewer.exe will open a XYZ data file if the
file is passed to it as a command line argument.  To open and view the datafile.xyz file using Viewer.exe, use the
following Action tab values:

Field Value
Command Execute Program
Target %SrcDrv%\viewer.exe
Command line arguments %SrcDrv%\files\xyzfiles\datafile.xyz
Working directory %SrcDrv%\files\xyzfiles
Mode Normal
Shutdown after Action Unchecked

Opening a Document
AutoPlay Menu Studio can open any document that has an associated viewer installed on the system.  Standard
document types include text files (*.txt), Word documents (*.doc), Write files (*.wri), Video (*.avi), Sound (*.wav),
Rich Text (*.rtf) and Help files (*.hlp).  Of course, you can also install other viewers to extend this capability to
meet your needs.

The “Open Document” command works just like choosing Start > Run in Windows.  This is called a shell execute.
The file is passed to the operating system, which then matches it up with a viewer.  This match is determined by
the file’s extension (.txt for example).  Viewers register the types of documents that they handle with the operating
system.  If you try to open a document that does not have a viewer associated with it, the file will not be opened.

What this means, is that if Windows does not ship with the viewer you require, then you must provide it for the
user.  For example, .pdf files can not be opened unless an Acrobat viewer is installed.  Since this is not included in
a standard Windows installation, you will probably want to include the viewer on your CD-ROM for those users
who do not have it.

Example:
There is a Word for Windows document called “order.doc” which is located in the “\docs” subdirectory of the
CD-ROM.  To open the file, you would use the following Action tab values:

Field Value
Command Open Document
Target %SrcDrv%\docs\order.doc
Command line arguments Not Applicable
Working directory Not Applicable
Mode Normal
Shutdown after Action Unchecked

Jumping to a Web Page
One of your company’s best marketing and informational tools may be its Web site.  AutoPlay Menu Studio
allows you to leverage this valuable resource in your menu.
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To open a Web page on the Internet, set the Command field to “Open URL (Web Site)” and specify the URL in the
Target field.  The web page will be opened with the user’s default web browser.

Example:
To jump to the Indigo Rose Corporation web site, use the following Action tab values:

Field Value
Command Open URL (Web Site)
Target http://www.indigorose.com
Command line arguments Not Applicable
Working directory Not Applicable
Mode Normal
Shutdown after Action Unchecked

Sending Email
The email feature of AutoPlay Menu Studio is implemented through the “Open URL (Web Site)” command.  You
just put mailto: and an email address in the Target field.  This will cause the user’s default email program to start
up and send email to the specified address.

Example:
To start an email message addressed to support@yourdomain.com, use the following Action tab values:

Field Value
Command Open URL (Web Site)
Target mailto:support@yourdomain.com
Command line arguments Not Applicable
Working directory Not Applicable
Mode Normal
Shutdown after Action Unchecked

Exploring a Directory
It is very common to let users browse the contents of the CD-ROM.  To open the folder using Windows Explorer,
set the Command field to “Explore Folder” and specify the directory path in the Target field.

Example:
To let the user explore the contents of the CD-ROM starting at the root directory, use the following Action tab
values:

Field Value
Command Explore Folder
Target %SrcDrv%
Command line arguments Not Applicable
Working directory Not Applicable
Mode Normal
Shutdown after Action Unchecked

Printing a Document
The Print feature is great for allowing your users to print a manual, an order form or any other information you
provide.  To print a document, set the Command field to “Print Document” and put the full path and filename in
the Target field.
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Note that the document’s viewer program must support the Print verb in order for this to work.  Most word
processors and other document viewers support this verb, but be sure to try it out.  Consult your viewer
documentation!

Example:
To print a document called “manual.doc” which is located in the “\docs” folder of the CD-ROM, use the
following Action tab values:

Field Value
Command Print Document
Target %SrcDrv%\docs\manual.doc
Command line arguments Not Applicable
Working directory Not Applicable
Mode Minimized
Shutdown after Action Unchecked

Playing a Multimedia File
Windows has many great built-in multimedia features that allow you to view .avi movies, .wav and .mid sound
files and more.  AutoPlay Menu Studio allows you to open and start playing a multimedia file.  This is done using
the “Play Multimedia” command

Example:
To open and play an .avi video called “intro.avi” from the “\media” folder on the CD-ROM, use the following
Action tab values:

Field Value
Command Play Multimedia
Target %SrcDrv%\media\intro.avi
Command line arguments Not Applicable
Working directory Not Applicable
Mode Normal
Shutdown after Action Unchecked

Custom Verbs
While the standard commands will handle most situations, certain viewers will support additional specialized
verbs.  If you do run across such a program, select “Custom Verb” as the command.  Enter the verb command
into the Custom verb field and fill in the other fields as appropriate.  You would have to find out from the
application’s manufacturer if the product supports shell execute commands other than open, print and play.
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Advanced Functions

Multilingual Menu Support
AutoPlay Menu Studio can automatically determine the default language of your user’s system at runtime (as set
in Control Panel > Regional Settings).  Simply create your menu as usual, translating your pages as required.  For
example, you might have pages called “English Start”, “French Start”, “Spanish Start” etc.  Each of these pages
could then branch off to other localized pages, as required.  After creating these starting pages, you simply match
them up with the language of your choice using the Startup Page tab.

Startup Page Tab
You can get to the Startup Page screen by selecting Project | Settings from the menu and clicking on the Startup
Page tab.

The Startup Page tab consists of a grid with two columns:  Language and Page Name.

The Language column lists the available languages.  The Page Name column is where you can choose from the
pages that are available in your menu.  The only language that may not be self-explanatory is the first one,
“Neutral”.  The page specified for Neutral will be displayed if the user has their system language set to neutral or
if their system is in a language that you have not explicitly set a startup page for.  In the latter case, the language
will have “<< Same as Neutral >>” listed as its startup page.  The page that is started is determined by the user’s
system settings at runtime (as set in Control Panel > Regional Settings).
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The Variable Manager
The Variable Manager is used to load custom variables for use in AutoPlay Menu Studio.  These variables can be
used in conditions (see page 37), in the paths to programs or most anywhere that you can enter text in AutoPlay
Menu Studio.

The custom variables are set at runtime with values obtained from the user’s System Registry.  This is an
advanced feature of AutoPlay Menu Studio.  While extremely powerful, it also requires you to have a more in-
depth knowledge of the operating system.  If you are unfamiliar with the use or format of the registration
database, you will want to consult a book on the subject.  Once you know what you’re doing, this feature gives
you a ton of flexibility.  It allows you to create a truly interactive, “smart” menu.

You open the Variable Manager by selecting Project | Variable Manager from the menu. The Variable Manager is
a grid with five columns.  The columns are:

Variable   The variable name.  Click on the name to change it from its default.  Although you can name the
variable virtually anything, there are a few guidelines to follow:

• No two variables can have the same name.
• A variable name cannot be the same as one of the built-in Variables (see page 47 for a listing).
• All variable names must be at least 3 characters.
• You should put percent (‘%’) signs on either side of the variable.  Although the program does not enforce this,

we strongly suggest it as a way to differentiate between variables and plain text.

Main key   The main registry key to query for the variable’s value.

Sub key   The sub key to query for the variable’s value.

Value name   The name of the value to get the data from.

Default   What to use if a value is not returned from the Registry.

Example:
Say that you want to check to see if a user’s system can view Adobe Acrobat files.  If it does, you want to hide the
button that says “Install Adobe Acrobat Reader”.  If it doesn’t have Adobe Acrobat support, you want to show
the button.
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The first step is to create a custom variable in the Variable Manager.  The second is to create a Hide Condition (see
page 37) for the “Install Adobe Acrobat Reader” button.

To create the custom variable, open the Variable Manager and enter the following values across one row.

Column Value
Variable %AcrobatInstalled%
Main Key HKEY_CLASSES_ROOT
Sub Key .pdf
Value Name Leave Blank
Default No

This will read the key “HKEY_CLASSES_ROOT\.pdf” from the Registry and store the result in the variable
named “%AcrobatInstalled%”.  If Acrobat documents are supported on the system, a value describing the
document type such as “AcroExch.Document” will be returned.  If the key can not be found (hence Acrobat isn’t
supported), the default value “No” will be returned instead.

To set the hide condition for the “Install Adobe Acrobat Reader” button, click on the button and open its
Properties screen.  Go to the Advanced tab.  Enable condition checking. Click on the Settings... button and enter
the following values:

Field Value
Value A %AcrobatInstalled%
Operator Not Equal
Value B No

For more information about Hide Conditions, please see page 37.

The Advanced Tab
The Advanced tab contains advanced options for an object or the entire menu.  The advanced options include
hiding the object (or the whole menu), setting a password for an object (or the whole menu) and setting Registry
values after an object has been selected or the menu has been loaded.
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You can set an object’s advanced options by opening the object’s Properties screen and clicking on the Advanced
tab.  You can get to the menu’s advanced options by selecting Settings... from the Project menu and clicking on the
Advanced tab.

Hiding an Object or the Menu Using Conditions
There may be times when you decide that you need to hide an object (or the whole menu) based on certain
conditions.  This can be accomplished by using the Condition screen from the Advanced tab.

When you set a condition, you are telling the menu not to display that object (or the whole menu) if the condition
is met.

To set a condition for an object:

• Select the object.
• Bring up the object’s Properties screen by double clicking, right clicking or by selecting Object | Properties

from the menu.
• Select the Advanced tab.
• Turn on the checkbox that says Enable condition checking.
• Click the Settings... button and set the condition.

To set a condition for the whole menu:

• Bring up the menu’s Settings screen by selecting Project | Settings... from the menu.
• Select the Advanced tab.
• Turn on the checkbox that says Enable condition checking.
• Click the Settings... button and set the condition.

The Condition screen contains the following fields:



AutoPlay Menu Studio 2.0 Pro 38

Value A   The first value that you are comparing.  This can be a literal number or character string or you can use
one of the built-in or Custom variables.

Operator   The logical operator that you want to use when comparing Value A to Value B.  Choose from Equals,
Greater than, Less than, Greater than or Equal, Less than or Equal, or Not Equal.

Value B   The second value that you are comparing.  This can be a literal number or character string or you can
use one of the built-in or Custom variables.

Example:
To make a condition that hides an object if the user’s operating system is Windows 95/98, enter the following
values in the object’s condition screen:

Field Value
Value A %OS%
Operator Equals
Value B Windows

Setting a Password for an Action
AutoPlay Menu Studio’s password checking feature allows you to prompt the user for a password or serial
number before performing an action or opening the menu.  This can be done through the Password screen on the
Advanced tab.

AutoPlay Menu Studio maintains a global password (serial number) list that your entire project shares.  As well,
you can set individual password lists for each object.  The menu password only uses the global list.  A password
list is simply that - a list of all passwords that will be accepted for that particular object.

To set up a password list for an object:

• Select the object.
• Bring up the object’s properties screen by double clicking, right clicking or by selecting Object | Properties

from the menu.
• Select the Advanced tab.
• Turn on the checkbox that says Enable password checking.
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• Click the Settings... button and set the password list.

To set up a password list for the entire menu:

• Bring up the menu’s Settings screen by selecting Project | Settings... from the menu.
• Select the Advanced tab.
• Turn on the checkbox that says Enable password checking.
• Click the Settings... button and set the password list.

The Password screen contains these items:

Message   The prompt that the user will see when asked for the password.

Valid passwords  Choose whether the object will use the Global list or the Local list.  The Global list is a list of
passwords that is available to all objects in your menu as well as the menu itself.  The Local list is only available to
that particular object.

Password List: A list of all valid passwords.  You can type in the passwords one by one, generate them with the
Generate button or  import them from a text file.

Generate   Opens a dialog that allows you to quickly generate and enter random or sequential passwords.  Please
see page 40 for more details about the Generate Passwords screen.

Export   Opens a dialog that prompts you for a filename and then saves your password list in ASCII text format.
Each password will be on its own line, followed by a carriage return-line feed pair.  You can then load the
passwords into your favorite text editor, spreadsheet or database.  Invaluable for maintaining and tracking
customer registration numbers.
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Import   Opens a dialog that prompts you for the filename of a password list to import.  The file must be
structured with one password per line, with a carriage return-line feed pair at the end of each line.  Passwords
must consist of standard ASCII characters and be no longer than 100 characters.

Clear   Clears all of the items currently in the Password List.

Generate Passwords Screen
The Generate Passwords screen is opened from the Password screen on the Advanced tab.  Please see page 38 for
more information about the Password screen.  The Generate Passwords screen contains the following fields:

Number of passwords to generate   The number of passwords to generate.

Generate sequential passwords   If selected, sequential passwords will be generated starting with the one
specified in First password.

First password   The first password in the sequence.  The following rules apply to the first password:

• Must consist only of alphanumeric characters and dashes (“A-Z”, “a-z”, “0-9”, “-“).
• Cannot contain spaces.
• Cannot start or end with a dash.

Generate random passwords   If selected, random passwords will be generated based on the mask entered in
Password mask.

Password mask   A mask of the passwords to generate.  The following mask characters may be used:

Character What will be generated
# Random number
* Uppercase letter (“A-Z”)
@ Lowercase letter (“a-z”)
? Random number or uppercase letter (“A-Z”,
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“0-9”)
- A dash character
A literal character The literal character will be displayed

Examples:

Mask Example of what could be generated
####-####-####-#### 4754-8345-1970-4486
CDKEY-*****-??? CDKEY-KWNGV-H39
@####@####@ f7986j2658y
???-INDIGO-???-??? LA5-INDIGO-8W0-9FM
*@@@@@@ Gpnenos
PW-1998-###### PW-1998-348521

When and How to use Passwords
AutoPlay Menu Studio’s password feature is used to prevent an action from executing until a valid password or
serial number is entered.  Now, you may be saying to yourself, “sure I can ask for a serial number before allowing
them to run my software, but what’s to stop them from just browsing the CD-ROM and running it from there?”.
There are two answers to that question, with increasing levels of security.

It really depends on how technically advanced your users are and the level of security that you require.  If you
know that your users are unlikely to browse the CD-ROM manually in order to find the program or document
that you are protecting, then this level of security may be sufficient.

If you need more security than this, you can combine the password feature with the update registry feature (see
the next section) to achieve a more complete form of security.

Keep in mind that no software security method is foolproof, and there are certainly additional tools available with
advanced encryption methods and protocols.  All of these solutions have tradeoffs in both cost and functionality.
The question becomes one of how much time and effort you want to put into your security system and what
benefits will be achieved.  AutoPlay Menu Studio’s password and registry features give you a good place to start.

Here is a basic outline of how you could implement your security system with AutoPlay Menu Studio:

1. Set a password for the action that runs your software (or the install routine, etc.)
2. On the same button, set the Update Registry feature to write a value to the Registry.  This Registry change

will only take place if the user correctly enters the password.
3. Write your software in such a way that it will not operate unless that specific Registry value is in place.
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Updating the Registry
AutoPlay Menu Studio’s registry update feature is used to make a change to the user’s Registry when a button is
clicked or the menu is started.  The information that you write to the registry can be used in several ways:

• Hide an option on a page of the menu.   For example, let’s say that you have an installer that you only want
the user to run once from the CD.  Using the Update Registry, Variable Manager and Button Condition
features you can hide the option after the first time the user runs it.

• Use the information in another program.  Write information out to the Registry which can then be retrieved
by your application.

Warning: This is an advanced feature of AutoPlay Menu Studio.  If you are unfamiliar with the format or function of the
Windows Registry, you should consult a reference book on the subject before attempting to use this feature.  You can cause
serious system problems if you corrupt the registry with invalid data!

To set the Registry Update for an object:

• Select the object.
• Bring up the object’s properties screen by double clicking, right clicking or by selecting Object | Properties

from the menu.
• Select the Advanced tab.
• Turn on the checkbox that says Enable registry update.
• Click the Settings... button and set the Registry Update.

To set the Registry Update for the entire menu:

• Bring up the menu’s Settings screen by selecting Project | Settings... from the menu.
• Select the Advanced tab.
• Turn on the checkbox that says Enable registry update.
• Click the Settings... button and set the Registry Update.
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The Registry Update screen contains the following fields:

Main   The main registry key.

Sub   The registry sub key.  Do not put a slash at the beginning of the key.

Name   The value name to set.

Type   The value type.  Choose between REG_DWORD (a number) or REG_SZ (a character string).

 Data   The value to insert
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Building and Distributing

How AutoPlay Menu Studio Builds a Menu
When AutoPlay Menu Studio builds a menu, it creates three to five core files (depending on whether you use the
video function at startup) and converts all of your graphic, sound and video files.  You are then responsible for
getting those files onto the CD-ROM along with your application and data files.  Here is a list of all files created
by AutoPlay Menu Studio and their destinations on your CD-ROM:

Filename Description Destination
autorun.exe The menu executable. The root directory of

the CD-ROM.
autorun.apm The configuration settings for

your menu.
The root directory of
the CD-ROM.

autorun.inf Handles the Windows
AutoPlay functionality,
which allows your menu to
start up automatically.

The root directory of
the CD-ROM.

startupv.exe Used to run your startup
video.

The root directory of
the CD-ROM*.

startupv.ap1 The configuration file for the
startup video.

The root directory of
the CD-ROM*.

DATA\*.dav Video files used in your
menu.

The DATA
subdirectory off of
the root of your
CD**.

DATA\*.dah
DATA\*.dal

Image files used in your
menu.

The DATA
subdirectory off of
the root of your
CD**.

DATA\*.daw Sound files used in your
menu.

The DATA
subdirectory off of
the root of your
CD**.

* This file will only be in your output directory if you configured the Startup Video option on the Project Settings
screen.

** The DATA subdirectory may be called something other than DATA if you specified otherwise in the Store
support files in subdirectory field on the Build screen.  If you turned off the Store support files in subdirectory
option, these files will be stored in the same directory as the core files.

Building Your Menu
The very best way to create your menu is to have a separate drive that you can use to simulate your CD-ROM.
This could be a local hard drive (or partition), a network drive or a removable drive (such as Jaz or Zip drives).
Simply set up the drive to look like your resulting CD-ROM.  Once everything is working properly, it will be easy
to create your master by burning the content “as-is” to your CD-R.
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A good first step is to copy your application and data files to the drive that you are using.  Set up this drive with
the idea that you will be copying the file structure verbatim to your CD.  For example, if your installation
program is called Setup.exe and will be located in the “\install” subdirectory on the CD-ROM, you should copy it
to the “\install” directory on your working drive.

Build Screen
The Build screen is opened when you select Project | Build from the main menu.  This screen sets the options that
you will need in order to build your menu.

Executable filename   The filename of the menu executable.  While we recommend using the conventional
“autorun.exe”, you can rename it to something else, such as autoplay.exe, setup.exe, start.exe, etc.

Output path   The path to output the menu to.  You can use a directory like “C:\output” or build to the root of a
drive (recommended) such as “E:\”.

Store support files in subdirectory   If checked, you can specify the folder to store the menu’s data files (images,
sounds etc.).  This folder is always relative to the Output path.  If unchecked, all of the data files will be stored in
the same directory as your output file.

Create autorun.inf file    Required for the menu to start up automatically when the CD-ROM is inserted.  If
selected, AutoPlay Menu Studio will create the autorun.inf file for you.  Windows 95/NT 4 and later look for this
file in the root directory of any CD-ROM that is inserted into the CD-ROM drive.  This file contains commands
that instruct the operating system on how to handle the CD-ROM.  In our case, it will tell the system to execute
our menu.
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Use external icon file   If checked, you can specify the full path and filename of in icon file (in standard .ICO
format) that you want to use to represent your CD-ROM as seen from the Windows Explorer.  You will need to
use a Windows icon resource editor to create this icon file.  If you leave the field blank, a default icon will be used.

Testing Your Menu
Once you have your testing drive set up properly and built your menu, the next step is to test it.  Make sure that
you try out all of the buttons on your menu.  Try the menu at different color depths (256 color, true color, etc.)
and resolutions (640 x 480, 800 x 600, etc.) to ensure that it looks good on a variety of systems.

Once your menu functions properly from your test drive, you are ready to burn a CD that you can take to other
systems for testing.  Again, try out all of the options and make sure that the menu is functioning properly.  If you
get any error messages or warnings, take note of them!  You should not get any error messages if everything is
working correctly.  If you do, go back to AutoPlay Menu Studio, fix the problems, rebuild and test again.

Creating Your CD-ROM
The final step in creating your masterpiece is to actually create your master CD-ROM that will be used for
distribution.  In some cases, your test CD-ROM may have functioned fine and becomes your final CD.  Other
times you will do some fine-tuning and then burn your master CD-ROM.

When burning your master, think carefully about what format that you will use.  Many CD-ROM authors have
packet writing or “rewriteable” software packages.  These are great for personal and test purposes, but are
usually not the best choice for widespread distribution.  The problem is that many older CD-ROM drives do not
support that format.

For the widest compatibility, we recommend that you use the ISO-9660 format.  This format will ensure your disk
is compatible with the vast majority of CD-ROM drives.  Keep in mind that you will need to use “8.3” filenames if
using the ISO-9660 format.  If you experience problems using any other format (such as Joliet), invariably our
technical support solution will be to switch to ISO-9660 and avoid packet-writing software for your master disk.
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Appendix A – Built-In Variables
Built-In Variables are used at design time to represent values that will be determined at run time.  These are
things that we cannot know at design time because they will change from one computer to the next.  For example,
the drive letter of the user’s CD-ROM drive may be D: or it may be E: etc.  In AutoPlay Menu Studio, we use the
variable %SrcDrv% to represent the drive that the menu program is run from.

Variable Description

%ColorDepth% The user’s system color depth:
4 = 16 colors
8 = 256 colors
15 = 32K colors
16 = 64K colors
24 = 16M colors
32 = 32-bit color

%OS% The user’s operating system.  Returns “Windows”
for Windows 95/98 or “WindowsNT” for all
versions of Windows NT.

%ScreenHeight% The user’s screen height in pixels.
%ScreenWidth% The user’s screen width in pixels.
%SrcDrv% The drive that the menu is run from.  (e.g. “D:”)
%SrcDir% The drive and directory that the menu is run from

(e.g. “D:\menu1”)
%SysDir% The user’s Windows System directory.  (e.g.

“C:\Windows\System”)
%WinDir% The user’s Windows directory.  (e.g.

“C:\Windows”)
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Appendix B - Troubleshooting
AutoPlay Menu Studio and Windows 3.1
AutoPlay Menu Studio is a 32-bit product that will only run under Windows 95/98 or Windows NT.  It will not
run under Windows 3.1 (even with Win32s installed).  The reason for this is that the Autoplay feature does not
exist in Windows 3.1.  The best thing to do for your Windows 3.1 users is to just include a 16-bit Setup.exe file in
the root directory.  Windows 3.1 users are used to searching for the install program anyhow.

If the AutoPlay Menu does not Startup
If your CD's autoplay menu does not appear to be working, run through the following diagnostics before seeking
technical support:

1.  When you double-click on the autorun.exe file in the root of the CD-ROM, does the menu start up?
NO:  You did not copy all of the files over to the CD when you made it.
YES:  Go on to 2.

2.  Double-click on My Computer. Right-click on the CD-ROM icon. Does "AutoPlay" appear as a choice?
NO:  You did not include all of the required files. Explore the CD-ROM and make sure all of the following
files are present:
autorun.inf
autorun.exe
autorun.apm
DATA subdirectory and its contents
All of these files/folders must exist at the root level of the CD-ROM in order for the AutoPlay feature to
function properly.
YES:  Go on to 3.

3.  Is the autoplay feature enabled for the CD-ROM drive?
NO: Enable the autoplay feature:

Windows 95
• Select Start > Settings > Control Panel.
• Double click the System icon to open the System Properties dialog.
• Select the Device Manager tab.
• Expand the CD-ROM node (it is usually the one at the top).
• Select the appropriate CD-ROM drive and click the Properties button.
• Select the Settings tab.
• Check the box that says Auto insert notification.
• Click OK to accept the change.
• Reboot your system.

Windows NT
• Edit the registry key HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Cdrom

and change Autorun 0x0 to 0x1 to enable autorun. Doing this will change the setting for all
users.

• To change it only for the current user, edit the registry key
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer
and set the value NoDriveTypeAutoRun from 0xff to 0x95.

• Reboot your system.
YES:  Go on to 4.
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4.  Are you working on Windows NT with Power User or Administrator rights?
YES:  Go on to 5.
NO:  By default, only users logged on to Windows NT with Power User or Administrator rights are
allowed to install software.  In Windows NT, files with the .inf extension are considered Setup
Information files.  As a result, the Autorun.inf file is not initiated if you do not have Power User or
Administrator rights.  To work around this issue, log on to Windows NT as a Power User or
Administrator.

5.  Have you rebooted the system without the CD-ROM in the drive?
NO:  Reboot without the CD-ROM in the drive and only insert it once the system is running and you have
logged in.
YES:  Go on to 6.

6.  Insert your Windows 95 CD-ROM (or any other CD-ROM that you know has an autoplay feature that works).
Does that CD-ROM's autoplay feature work?

NO:  The autoplay feature is disabled (see Question 3) or not functioning on your system.
YES:  You have not created and/or copied your autoplay menu correctly.

7.  Do you have Multiple CD-ROM drives?
YES:  On some systems, the autoplay feature will only work on the first or master drive.

8.  Is your burner the only CD drive that you have?
YES:  Some packet writing drivers lock and ignore autoplay notification. Try your CD on another system
or disable the packet drivers according to your drive/software documentation.

Using Long Filenames on Your CD-ROM
It is not generally a good idea to use long filenames or directory names on your CD-ROM.  The ISO-9660 CD-
ROM format does not support long filenames and since it is the most widely accepted standard for CD-ROM, you
should follow the 8.3 naming convention.  Although there are formats that do support long filenames such as
Joliet, your CD may not be readable on some older drives and systems.

The Images Don’t Appear or the Sounds Don’t Play
If you burn your CD-ROM only to realize that your background image doesn’t appear or that your sounds don’t
play, don’t panic.  This can happen if you don’t burn all of the data files to the CD.  Make sure that you have
copied the DATA directory and it’s contents to the CD.  See page 44 for more details about file locations.
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TM

The Award Winning Point and Click Installer Builder

Don’t waste time learning proprietary scripting languages when you can point and click your way to a
professional, bulletproof installation routine!  Setup Factory is used by thousands of companies worldwide – and
with good reason. Our innovative Project Wizard helps walk you through the process in only minutes. And while
competitive “express” products may leave you feeling confined – Setup Factory gives you the flexibility you need
to customize the installation to fit your needs!

Flexible and Powerful
Customize the setup to fit your needs using only your mouse.  Collect info.  Ask for a password.  You get the idea.
When you’re satisfied, click on the “Build” button.  Your files are compressed, the setup program is created and
then everything gets combined into a single, self-contained setup.exe file.  This file can then be split over as many
diskettes as needed, placed on a CD-ROM or put on a web site.

Special Features
Even though Setup Factory is easy to use, we sure didn’t sacrifice any flexibility.    It grows with your changing
needs!  Just some of the features include:  Install files to any location  -  Create shortcut icons and folders  -
Selective install (Complete, Typical, Minimum, Custom)  -  Full featured uninstall  -  Build setups for Windows
95/NT and 3.1  -  Setup expiration dates, passwords and serial numbers  -  Automatic font registration  -  System
configuration checking  -  Execute external programs as part of the setup (e.g. QuickTime, 3rd party setups etc.)  -
Automatic registration of ActiveX controls  -  Modify system files (bat/sys/ini/registry)  -  Background gradients
and bitmap tiling  -  True multilingual support (English, French, Spanish, German, Italian etc.)  -  Customizable
screens and messages  -  Intuitive, user-friendly setup process  -  Royalty-free!  -  Much more!

http://www.indigorose.com/setup


